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ABSTRACT
Life cycle cost analysis (LCCA) is recognized by public agencies as an effective tool to
assist in the selection of highway construction, maintenance, and rehabilitation treatments.
Accordingly, the Federal Highway Administration (FHWA) has developed an LCCA
methodology that will likely become the standard in the industry. The methodology can be used
to evaluate the life cycle costs (LCC) of paving materials with additives/modifiers, such as
hydrated lime.
This report uses information from past highway projects to:
•

identify the benefits and costs of adding lime;

•

compile past performance data into an LCCA model; and

•

compare the LCCs for asphalts with and without lime.

Estimated lives used in the LCCA model are based on interviews and on engineering judgment.
Practitioners can use project-specific data with the LCCA software to generate project-specific
estimates of life cycle costs.
This report presents the LCCA results for interstate and state highway projects. The
findings show that lime is the most cost effective design for all of the applications studied. Life
cycle cost savings from lime are, on average, $2 to $3 per square yard; or, $13,000 to
$21,000/lane mile (13% to 15% of project life cycle costs). These results are based on the
widely accepted use of lime as an additive that reduces stripping. Additionally, new information
shows that lime creates other benefits in asphalt, which would further increase the life cycle
benefits of using lime.

ii

ACKNOWLEDGMENTS
The authors are grateful for the assistance of the following agencies and contractors that
provided the information to perform life cycle cost comparisons:
•
•
•
•
•
•
•
•
•
•
•

Agencies
Arizona
California
Colorado
FHWA (WFLHD)
Georgia
Mississippi
Oregon
Nevada
South Carolina
Texas
Utah

•
•
•
•
•
•
•
•
•
•

Contractors
APAC
FNF Construction
Granite Construction
Kiewit Pacific
Lafarge
C.W. Matthews Contracting
Morse Brothers
Staker Construction
Dean Word Company
Young Contractors

The information provided and used in the analyses was verified by those surveyed.

DISCLAIMER
The contents of this report reflect the views of the authors who are responsible for the
facts and the accuracy presented herein. The contents do not necessarily reflect the official
views of the agencies and contractors that provided information in support of the study. Users of
the LCCA model need to apply their judgment when using the results of this report or the
software described in this volume.

iii

TABLE OF CONTENTS
Page
1.0 INTRODUCTION .....................................................................................................................1
1.1 Overview..............................................................................................................................1
1.2 Assumptions.........................................................................................................................1
1.3 Limitations ...........................................................................................................................2
2.0 INSTALLATION ......................................................................................................................3
2.1 Recommended System Attributes........................................................................................3
2.2 Installation............................................................................................................................3
Installation Using a Compact Disc ......................................................................................4
Installation Using a File Located on a Web Site..................................................................4
3.0 USING THE SOFTWARE ........................................................................................................6
3.1 Main Module Form ..............................................................................................................6
Executing the Software Program .........................................................................................6
Main Module Features .........................................................................................................8
Selecting an Analysis Approach ........................................................................................13
Opening an Existing Project ..............................................................................................15
Deleting an Existing Project ..............................................................................................16
Using the Help System.......................................................................................................18
3.2 Project Inputs Form............................................................................................................22
Project Information ............................................................................................................23
Initial Construction ............................................................................................................25
Maintenance Treatments....................................................................................................30
Rehabilitation Treatments..................................................................................................34
User Costs ..........................................................................................................................39
Analysis Parameters...........................................................................................................40
Saving Project Information ................................................................................................41
Running an Analysis ..........................................................................................................42
3.3 Results Viewer Form .........................................................................................................43
4.0 REFERENCES ........................................................................................................................51

iv

LIST OF FIGURES
Figure

Page

1

Selecting the LCCA Software Program Using the Windows Start Menu ...........................7

2

Disclaimer for the LCCA Software .....................................................................................8

3

Main Module Form with Splash Screen ..............................................................................9

4

Form for Selecting an Analysis Approach or Opening an Existing Project ......................10

5

Menu Choices in the File Menu.........................................................................................11

6

Menu Choices in the Units Menu ......................................................................................12

7

Menu Choices in the Help Menu .......................................................................................13

8

The About Dialog ..............................................................................................................14

9

Selecting an Analysis Approach ........................................................................................15

10

Selecting an Existing Project to Open ...............................................................................16

11

Dialog Indicating Results Exist for the Project Being Opened..........................................16

12

Form Used for Deleting Projects from the Database .........................................................17

13

Selecting a Project to Delete from the Database................................................................17

14

Dialog to Confirm Deletion of a Project From the Database.............................................18

15

Contents of the Help System Dialog..................................................................................19

16

Example of the Contents of the Help System (Software Overview) .................................20

17

Help System Dialog Showing the Index for the Help System...........................................21

18

Help System Showing the Find Feature Tab .....................................................................22

19

Project Info Tab of the Project Inputs Form ......................................................................24

20

Selecting the Lane Configuration for the Project ..............................................................24

v

LIST OF FIGURES (Continued)
Figure

Page

21

Using the Include Check Boxes to Indicate Which Lanes to Include................................25

22

Initial Construction Tab of the Project Inputs Form..........................................................26

23

Selecting the Mixture Type for Initial Construction..........................................................27

24

Selecting the Units for Unit Costs .....................................................................................28

25

Form for Editing Default Parameters for Mixture Types ..................................................29

26

Controls for Creating a New Mixture Type.......................................................................30

27

Maintenance Tab of the Project Inputs Tab.......................................................................31

28

Selecting the Maintenance Treatment Type ......................................................................32

29

Switching Off Maintenance Treatments ............................................................................32

30

Form for Editing Default Parameters for Maintenance Treatments ..................................33

31

Controls for Creating a New Maintenance Treatment.......................................................34

32

Rehabilitation Tab of the Project Inputs Form ..................................................................35

33

Selecting the Rehabilitation Treatment Type ....................................................................36

34

Specifying a Second Treatment Type for Pavement Alternative 1....................................36

35

Selecting the Second Treatment Type for Pavement Alternative 1...................................37

36

Form for Editing Default Parameters for Rehabilitation Treatments ................................38

37

Controls for Creating a New Rehabilitation Treatment.....................................................39

38

User Costs Tab of the Project Inputs Form........................................................................40

39

Analysis Tab of the Project Inputs Form ...........................................................................41

40

Display of Analysis Progression........................................................................................42

41

Analysis Tab Displaying the View Results Button............................................................43

vi

LIST OF FIGURES (Continued)
Figure

Page

42

Results Viewer Form .........................................................................................................44

43

Comparison Plot of the Cumulative Present Worth Cost for Both Alternatives ...............45

44

View Menu of the Results Viewer Form ...........................................................................45

45

Summary of Inputs as Displayed by the Results Viewer Form .........................................46

46

File Menu of the Results Viewer .......................................................................................46

47

Page Setup Feature of the Results Viewer.........................................................................47

48

Print Preview Feature of the Results Viewer.....................................................................47

49

Dialog for Exporting Results to Disk.................................................................................48

50

Summary of Results for a Probabilistic Analysis ..............................................................49

51

Cumulative Probability Plot...............................................................................................50

vii

1.0 INTRODUCTION
1.1

Overview
The LCCA (life cycle cost analysis) software package is a Windows-based

application that was developed to perform economic analyses of two pavement
alternatives that are subject to future maintenance and rehabilitation (M&R) activities.
The methodology is based on the approach developed by the Federal Highway
Administration (Walls and Smith, 1998). The software allows analyses for both new
construction and rehabilitation projects and allows inclusion of lane rental fees as a
surrogate for user delay costs. It also supports both deterministic and probabilistic
analyses. The deterministic approach uses mean (average) values of the input variables.
In the probabilistic approach, real world variability of certain input variables is mimicked
through a Monte Carlo simulation process, which is based on the means and standard
deviations of the input variables.
The graphical user interface (GUI) interacts with a 32-bit Microsoft Access 97
database. All data utilized by the LCCA software package is contained in the database.

1.2

Assumptions
Several assumptions were made in the development of the LCCA software

package. These are summarized as follows:
1) Vehicle operating costs and crash costs have been assumed to be equivalent for
the two alternatives under consideration.
2) Lane rental fees have been used as a surrogate for user delay costs.
3) User costs associated with a new construction project for initial construction are
assumed equal to zero.
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4) Salvage value (credit for remaining life) is determined as a prorated cost of the
final rehabilitation activity based on the portion of life consumed relative to the
expected life of the rehabilitation treatment.
5) The parameters varied in the Monte Carlo simulation process (i.e., treatment lives,
treatment costs, and the discount rate) have been assumed to follow normal
(Gaussian) distributions. Low and high estimates for these parameters have been
assumed to represent the 10 and 90 percentile values, respectively.

1.3

Limitations
The LCCA software has several limitations. The major limitations of the

software are listed below:
1) The analysis results are only as good as the inputs. Every effort should be made
to ensure that the inputs are accurate.
2) Only one type of maintenance treatment can be applied to a pavement alternative.
3) Future costs are in real (constant) dollars and the discount rate is a real discount
rate (one that does not reflect an inflation premium).
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2.0 INSTALLATION
This section provides guidance for installing the LCCA software package. It
includes a description of the recommended attributes of the computer system on which
the software is to be installed, followed by instructions for installing the software.

2.1

Recommended System Attributes
The LCCA software package was developed to run on a computer system that has

reasonably up-to-date hardware components. As a guide to the minimum system
requirements on which the software will run, the following system attributes are required
and/or recommended:
•

Operating system: Windows 98, Windows 2000, or Windows NT 4.0 is required.

•

Central processing unit (CPU): Pentium is required; Pentium II or better is
recommended.

•

Free hard disk space: at least 20 megabytes is required; more is recommended.

•

Random access memory (RAM): 16 megabytes is required; 64 megabytes or more
is recommended.

•

Monitor type and resolution: VGA set to 1024 × 768 pixels is required; SVGA or
better set to 1024 × 768 pixels or greater is recommended.

2.2

•

Drives: Compact disc (CD) drive is required.

•

Mouse or other similar device.

Installation
The LCCA software package is bundled in an installation program contained on

the LCCA Software Package compact disc (CD) or in a file located on the National Lime
Association web site (or other web site to which the NLA web site directs you). You
3

must execute this program to be able to run the LCCA software on your computer system
and such a system must have the minimum attributes detailed in Section 2.1 of this user’s
guide. The following sections provide guidance for installing the LCCA software
package.
Installation Using a File Located on a Web Site
Use the following steps to install the LCCA software package on a computer
using a file located on a web site:
1. Download the installation package file (e.g., NLA_LCCA_v1_3.exe, or similar)
from the web site address to which the NLA has directed you. Tip: Download the
file to a location on your hard disk such that the file can be easily found (e.g.,
C:\Temp).
2. Click on the Windows Start menu button and select Run…
3. Select Browse… and when the Browse dialog box opens, navigate to the location
to which you downloaded the installation package file.
4. Double-click on the installation package file (or highlight the file and click on
Open).
5. Click on the OK button on the Run form.
6. Follow the instructions given in the Setup Wizard.
Installation Using a Compact Disk (CD)
Use the following steps to install the LCCA software package on a computer from
a compact disc:
1. Insert the LCCA Software Package CD in the CD drive.
2. Click on the Windows Start menu button and select Run…
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3. Select Browse… and when the Browse dialog box opens, navigate to the CD
drive.
4. Double-click on the Setup.exe file (or highlight the file and click on Open).
5. Click on the OK button on the Run form.
6. Follow the instructions given in the Setup Wizard.
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3.0 USING THE SOFTWARE
This section provides guidance for using the LCCA software package. It
addresses the type of analysis approach to use, details regarding the required inputs for a
particular life cycle cost analysis (LCCA), and details about viewing and printing results.

3.1

Main Module Form

Executing the Software Program
The LCCA software can be executed using the Windows Start menu as indicated
in Figure 1. Clicking on the Start button, scrolling the mouse to highlight the Programs
menu choice, then highlighting and clicking on the NLA LCCA Version 1.3 menu choice
accomplishes this. Note that executing the software can be accomplished in other ways
including creating a shortcut on the desktop, using the Windows Explorer, or using the
My Computer feature. The Windows help system provides details on how to use these
features.
Executing the program loads the Main Module form into memory and shows the
Disclaimer dialog shown in Figure 2. Either answer “no” by clicking on the button
labeled “No, I do not want to use the software!”, which exits the software, or answer
“yes” by clicking on the button labeled “Yes, I want to use the software!”, which
indicates that you accept the disclaimer. Answering “yes” continues to load the software
by first displaying the Splash Screen shown in Figure 3, which is shown only briefly.
After the Splash screen, the form shown in Figure 4 is displayed. This form is used to
select the type of approach (deterministic or probabilistic) to use for a given life cycle
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Figure 1. Selecting the LCCA Software Program Using the Windows Start Menu.
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Figure 2. Disclaimer for the LCCA Software.

cost analysis or to open an existing (previously saved) project. Prior to describing the
inputs required for a life cycle cost analysis, the following paragraphs provide details
regarding the Main Module form.

Main Module Features
The Main Module form is a container for all other forms that make-up the LCCA
software package. As indicated in Figure 4, it contains a menu bar at the top of the form
with three menu choices: File, Units, and Help.

8

Figure 3. Main Module Form with Splash Screen.
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Figure 4. Form for Selecting an Analysis Approach or Opening an Existing Project.
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File Menu
The File menu contains the two menu choices shown in Figure 5. Clicking on the
word File, or holding down the Alt key and pressing the F key, displays these menu
choices. Once displayed, clicking on a particular menu choice, or holding down the Alt
key and pressing the underlined letter in the menu choice, selects a particular menu
choice. Under the File menu selecting the Delete… menu choice allows previously saved
projects to be deleted whereas selecting the Exit menu choice quits the LCCA software
package. Deleting existing projects is discussed in further detail below (see Deleting an
Existing Project in this section).

Figure 5. Menu Choices in the File Menu.
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Units Menu
The Units menu contains the menu choices shown in Figure 6. The menu is used
to select the units to be used in a given LCCA. Selecting the US menu choice sets the
units to U.S. Customary units, whereas selecting the SI menu choice sets the units to
Système Internationale d’ Unités (metric units). The type of units in force is indicated by
the check mark adjacent to the menu choice. For example, Figure 6 indicates that U.S.
Customary units have been previously selected and are currently in force. The units in
force at the time the LCCA software package is terminated (exited) become the default
units the next time the software package is run. This allows selecting either US units or
SI units as the default units. Units can only be changed when the form shown in Figure 4
is displayed (i.e., units cannot be changed “on-the-fly” in the middle of an analysis).

Figure 6. Menu Choices in the Units Menu.
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Help Menu
The Help menu contains the menu choices shown in Figure 7. Selecting either the
Contents menu choice or the Search for Help On… menu choice opens the Help system.
Further details of the Help System are discussed below (see Using the Help System later
in this section). Selecting the About menu choice displays the About dialog shown in
Figure 8, which has no functionality other than to display the information shown.

Figure 7. Menu Choices in the Help Menu.

Selecting an Analysis Approach
The LCCA software provides two analysis approaches: 1) the deterministic
approach, and 2) the probabilistic approach. Deterministic analyses do not consider
variability in that only the mean (average) values of the inputs are utilized in the analyses.
13

Figure 8. The About Dialog.

Deterministic analyses are appropriate whenever the variability of the maintenance and
rehabilitation treatment lives and costs are not known. Probabilistic analyses, on the
other hand, consider the variability of the M&R treatment lives and costs (as well as
variability in the discount rate) through a Monte Carlo simulation process. However, this
form of analysis requires knowledge (or estimation) of the variability of the inputs varied
during the analysis. The Federal Highway Administration (FHWA) recommends use of
the probabilistic approach (Walls and Smith, 1998).
The form used to select the analysis approach was shown in Figure 4 and is
shown on a slightly larger scale in Figure 9. Clicking on the radio button (see Figure 9)
adjacent to the desired analysis approach (or the words themselves) selects the approach
to be used for new projects. Figure 9 indicates that the deterministic approach has been
selected as indicated by the black dot in the radio button. Once an analysis approach is
selected, click on the OK button to open the Project Inputs form (see Section 3.2).
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Figure 9. Selecting an Analysis Approach.
Opening an Existing Project
The form for selecting an analysis approach (Figure 9) also includes a radio button and
drop-down list for opening existing (previously saved) projects. Clicking on the radio
button adjacent to the words “Open an Existing Project” (or the words themselves)
activates the drop-down list as shown in Figure 10. Clicking on the drop-down button
( ) at the right side of this control displays the contents of the list. Highlighting and
clicking on the name of the desired project selects the project. Figure 10 indicates that
the project named “Arizona Interstate Deterministic” is being selected. Once selected,
clicking on the OK button opens the project. If results exist for the project, a dialog
shown in Figure 11 is displayed indicating that results exist and asks if you want to
display them. Answering “yes” by clicking on the Yes button opens the Results Viewer
form (see Section 3.3) whereas answering “no” by clicking on the No button opens the
Project Inputs form (see Section 3.2).
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Figure 10. Selecting an Existing Project to Open.

Figure 11. Dialog Indicating Results Exist for the Project Being Opened.

Deleting an Existing Project
Existing projects can be deleted from the database using the File/Delete… feature.
Clicking on the File menu and selecting the Delete… menu choice (see Figure 5)
accesses this feature. This feature has been provided so that the database can be
maintained to a reasonable size1.
1

A substantial amount of information is saved to the database whenever probabilistic analyses are run.
When numerous projects of this type are contained in the database, the database gets very large and this can
substantially reduce the performance (speed) of the analysis process. Thus, for best performance, it is
recommended that the number of projects utilizing the probabilistic approach be kept to a minimum.
Saving Project Information in Section 3.2 provides further details on how projects of this type can be
retained in the database while keeping the database to a reasonable size.
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Figure 12 shows the form that is displayed when the File/Delete… feature is
accessed. It includes a drop-down list of all of the projects contained in the database.
Clicking on the drop-down button ( ) at the right side of this control displays the
contents of the list as shown in Figure 13. Highlighting and clicking on the name of the
project selects it for deletion. This figure indicates that the project named “Mt. Rose –
Arlington to Wells” is being selected for deletion. Once the project is selected, click on
the Delete button to delete the project from the database.

Figure 12. Form Used for Deleting Projects from the Database.

Figure 13. Selecting a Project to Delete from the Database.
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You will be asked to confirm the deletion as indicated in Figure 14. Answering
“yes” by clicking on the Yes button will result in the LCCA software deleting the
selected project from the database whereas answering “no” by clicking on the No button
will abort the deletion process and the selected project will be preserved in the database.
Any time a project is deleted from the database, the LCCA software compacts the
database resulting in a reduction in its size.

Figure 14. Dialog to Confirm Deletion of a Project From the Database.

Using the Help System
Most elements of this user’s guide are contained in an on-line Help system (i.e., a
system that can be accessed from within the LCCA software package). Clicking on the
Help menu and selecting either the Contents or Search For Help On… menu choices (see
Figure 7) opens the Help system. Selecting the Contents menu choice displays the
Contents page of the Help system dialog as shown in Figure 15.
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Figure 15. Contents of the Help System Dialog.

Clicking on the topic (shown in green lettering and underlined) displays contents
of the help system for the topic. For example, Figure 16 indicates that the topic
Overview (under the topic heading of INTRODUCTION) has been selected and the
contents of the Help system for this topic have been displayed.
Selecting the Search For Help On… menu choice from the Help menu displays
the index to the Help system as shown in Figure 17. Highlighting an item in this list and
clicking on the Display button displays the contents of the Help system for the selected
item.
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Figure 16. Example of the Contents of the Help System for the Topic Covering the Software Overview.
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Figure 17. Help System Dialog Showing the Index for the Help System.

The Help system also contains a “find” feature that can be used to search the Help
system. Figure 18 shows an example search where the letters p and r were entered in the
box at the top of the dialog.
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Figure 18. Help System Showing the Find Feature Tab.

3.2

Project Inputs Form
This section provides detailed information regarding the required inputs for

conducting life cycle cost analyses. It provides guidance for defining:
•

project specific information;

•

information regarding the initial construction alternatives;

•

maintenance treatments applied to the initial construction and rehabilitation
alternatives;

•

rehabilitation treatments applied throughout the analysis period;

•

user costs in terms of lane rental fees; and

•

analysis parameters.
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Project Information
Figure 19 shows the Project Info tab of the Project Inputs form. Use this tab to
enter information about the project. Controls colored yellow indicate required input
whereas controls colored white indicate optional input. For example, Figure 19 indicates
that a project name, lane configuration, lane width, and project beginning and ending
stations are required, whereas all information on the Project Location and Description
frame is optional. The following provides further details about the controls on this tab:
•

Project Name (Required): Use this text box to enter a name for the project.
Clicking on the yellow box and typing a name accomplishes this. The name can
be up to 100 characters in length (spaces count as characters). Figure 19 indicates
that the name “Demo” has been entered for the project name.

•

Project Location and Description (Optional): Double-click on the words within
these text boxes and type information to replace the text. State, County, Route,
and Project ID are limited to 20 characters whereas the Description can be up to
255 characters in length (spaces count as characters).

•

Lane Configuration and Dimensions (Required): Use the controls on this frame to
identify the number of lanes, included lane widths, and project termini. The lane
configuration is selected from the drop-down list in the upper left corner of this
frame as shown in Figure 20, whereas the number of lanes to include for the
project is indicated by the check boxes. For example, Figure 20 indicates only
one lane is to be included whereas Figure 21 indicates three lanes are to be
included for the project.
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Figure 19. Project Info Tab of the Project Inputs Form.

Figure 20. Selecting the Lane Configuration for the Project.
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Figure 21. Using the Include Check Boxes to Indicate Which Lanes to Include.
•

Project Length (Required): Use the two text boxes on the Project Length frame to
enter the beginning and ending locations of the project. Enter these in stations.
For example, Figure 21 indicates a beginning location at Station 0+00 and an
ending location at Station 528+00, giving a project length of 10 miles (for 3 lanes,
the total project area equals 30 lane-miles).

Initial Construction
Figure 22 shows the Initial Construction tab of the Project Inputs form. Use the
controls on this tab to enter information about the two alternatives for which the life cycle
cost analysis is being conducted. Controls colored yellow indicate required input,
whereas controls colored white indicate optional input. The following provides further
details about the controls on this tab:
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Figure 22. Initial Construction Tab of the Project Inputs Form.

•

Include time to perform initial construction activity in the calculation of user
costs: Check the check box (default), as shown in Figure 22, to include user costs
for the initial construction activities. Uncheck the check box to exclude user
costs.

•

Pavement Alternative 1: Use the controls on this frame to indicate the mixture
type, the production rate for constructing the pavement layer (for rehabilitation
projects), the expected life of the pavement, and unit cost for construction or total
cost for construction. Use the drop-down list to select the mixture type as
indicated in Figure 23. Use the text box below the drop-down list to indicate the
production rate in lane-miles/day or lane-kilometers/day for constructing the
pavement. Use the text boxes on the Expected Life of Pavement Alternative
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Figure 23. Selecting the Mixture Type for Initial Construction.
frame to enter the mean expected life, in years, of the pavement. If running a
probabilistic analysis, enter the low and high estimates for the expected life of the
pavement. The low estimate is assumed to correspond to the 10th percentile value
for the life (i.e., 1 in 10 projects fail to achieve this life) and the high estimate is
assumed to correspond to the 90th percentile value (i.e., 1 in 10 projects exceed
this life). You can use either unit cost information (default) or total cost
information to indicate the cost for initial construction. If using unit cost
information, enter the mean unit cost for the mixture and select the units from the
drop-down list as shown in Figure 24. Note that you can specify sq yd-in, sq yd,
or ton in US units and sq m-25mm, sq m, or Mg in SI units. If conducting a
probabilistic analysis, also enter the low and high estimates of the unit cost.
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These are assumed to correspond to the 10th and 90th percentile values,
respectively. Also, if you select sq yd-in (or sq m-25mm) as the units,

Figure 24. Selecting the Units for Unit Costs.
you will need to specify a thickness for the pavement layer. If you want to use
total cost information, click on the check box on the Use total cost information
frame and enter a value for the mean total cost for construction. If running a
probabilistic analysis, also enter the low and high estimates for the total cost of
construction. These are assumed to correspond to the 10th and 90th percentile
values, respectively.
•

Pavement Alternative 2: Use the controls on this frame in the same manner as for
Pavement Alternative 1 to indicate values for Pavement Alternative 2.

You can edit the default values for the mixture type parameters. Clicking on the
View/Edit Default Parameters for Mixture Types… button opens the form shown in
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Figure 25. Changing the values on this form changes the values stored in the database.
Values stored in the database are default values.

Figure 25. Form for Editing Default Parameters for Mixture Types.

New mixture types can be added to the database through the form shown in
Figure 25. Clicking on the Add New… button changes the appearance of the form to that
shown in Figure 26. Type in the values requested for the new mixture type in the text
boxes and click on the OK button to store the new mixture type in the database. Note
that all information requested is required to create the new mixture type. Once created,
the grid shown in Figure 25 can be used to modify the default values. Clicking on the
Cancel button changes the appearance of the form back to that shown in Figure 25. If a
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new mixture type was not created, clicking on the Cancel button cancels creation of a
new mixture type.

Figure 26. Controls for Creating a New Mixture Type.

Maintenance Treatments
Figure 27 shows the Maintenance tab of the Project Inputs form. Use the controls
on the tab to enter information about the maintenance treatments to be applied to the two
initial construction alternatives as well as the treatments applied to future rehabilitation
alternatives. Use the controls on the upper frame to enter this information for the two
initial construction alternatives and the controls on the lower frame for maintenance
treatments applied after a rehabilitation treatment has been applied to the alternatives.
Note that user costs can be determined for the maintenance activities. Clicking on the
check box at the top of the tab activates this feature.
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Figure 27. Maintenance Tab of the Project Inputs Tab.
Select the maintenance treatment type from the drop-down list as shown in Figure
28 and enter the application frequency (in years), the unit cost (in $/sq yd or $/sq m), and
if including user costs, the production rate for applying the treatment (in lane-miles/day
or lane-kilometers/day). If conducting a probabilistic analysis, also enter the minimum
and maximum application frequencies (10th and 90th percentile values, respectively) and
the low and high estimates for the unit cost of the treatment (also 10th and 90th percentile
values, respectively).
Note that you do no have to include maintenance treatments in the analysis.
Clicking on the Include check box next to the drop-down list for a particular treatment
switches inclusion of a treatment on and off. For example, Figure 29 indicates that
maintenance treatments will not be applied to the initial construction alternatives but that

31

Figure 28. Selecting the Maintenance Treatment Type.

Figure 29. Switching Off Maintenance Treatments.
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maintenance treatments will be applied once the initial construction alternatives have
been rehabilitated.
You can edit the default values for the maintenance treatment parameters.
Clicking on the View/Edit Default Parameters for Maintenance Treatments… button
opens the form shown in Figure 30. Changing the values on this form changes the values
stored in the database. Values stored in the database are default values.

Figure 30. Form for Editing Default Parameters for Maintenance Treatments.

New maintenance treatments can be added to the database through the form
shown in Figure 30. Clicking on the Add New… button changes the appearance of the
form to that shown in Figure 31. Type in the values requested for the new maintenance
treatment in the text boxes and click on the OK button to store the new treatment in the
database. Note that all information requested is required to create the new treatment.
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Clicking on the Cancel button changes the appearance of the form back to that shown in
Figure 30. If a new treatment was not created, clicking on the Cancel button cancels
creation of a new maintenance treatment.

Figure 31. Controls for Creating a New Maintenance Treatment.

Rehabilitation Treatments
Figure 32 shows the Rehabilitation tab of the Project Inputs form. Use the
controls on this tab to select/enter information regarding the rehabilitation treatments to
be applied to the initial construction alternatives. Use the upper frame to enter
information for Pavement Alternative 1 and the lower frame to enter information for
Pavement Alternative 2. You can specify up to four different rehabilitation treatments
per alternative. However, note that only one treatment need be specified (i.e., only one
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treatment type is required). The software will apply the last treatment specified
repeatedly until the end of the analysis period is reached. For example, if only one
treatment is specified, it will be the only rehabilitation treatment applied throughout the
analysis period.

Figure 32. Rehabilitation Tab of the Project Inputs Form.

Use the drop-down list to select the rehabilitation treatment type as shown in
Figure 33. Clicking on the 2nd, 3rd, and 4th check boxes allows you to specify additional
rehabilitation treatments for the pavement alternative. For example, Figure 34 indicates a
second rehabilitation treatment is be specified for Pavement Alternative 1 and Figure 35
shows selection of the second treatment type from the drop-down list.
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Figure 33. Selecting the Rehabilitation Treatment Type.

Figure 34. Specifying a Second Treatment Type for Pavement Alternative 1.
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Figure 35. Selecting the Second Treatment Type for Pavement Alternative 1.

Use the text boxes to enter values for the mean expected life, mean unit costs, and
production rates for each treatment specified. If conducting a probabilistic analysis, also
enter low and high estimates for the expected life of the treatments and the low and high
estimates for the unit costs. In both cases, the low value is assumed to correspond to the
10th percentile value and the high estimate is assumed to correspond to the 90th percentile
value.
You can edit the default values for the rehabilitation treatment parameters.
Clicking on the View/Edit Default Parameters for Rehabilitation Treatments… button
opens the form shown in Figure 36. Changing the values on this form changes the values
stored in the database. Values stored in the database are default values.
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Figure 36. Form for Editing Default Parameters for Rehabilitation Treatments.

New rehabilitation treatments can be added to the database through the form
shown in Figure 36. Clicking on the Add New… button changes the appearance of the
form to that shown in Figure 37. Type in the values requested for the new rehabilitation
treatment in the text boxes and click on the OK button to store the new treatment in the
database. Note that all information requested is required to create the new treatment.
Clicking on the Cancel button changes the appearance of the form back to that shown in
Figure 36. If a new treatment was not created, clicking on the Cancel button cancels
creation of a new rehabilitation treatment.
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Figure 37. Controls for Creating a New Rehabilitation Treatment.

User Costs
Figure 38 shows the User Costs tab of the Project Inputs form. Use the controls
on this tab to specify the lane rental fees to be used when a work zone is in place on the
facility. These are used in conjunction with treatment production rates and the area of the
project to determine user costs associated with performing maintenance and rehabilitation
treatments, if inclusion of user costs were selected on the maintenance and rehabilitation
tabs, respectively.
Use the radio buttons to indicate the expected traffic level and enter the lane rental
fee (in $/lane-mile/day for US units or $/lane-kilometer/day for SI units) in the
corresponding text box. For example, Figure 38 indicates that a moderate traffic level
has been selected for the facility and that the lane rental fee is $5000/lane-mile/day.
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Figure 38. User Costs Tab of the Project Inputs Form.
Analysis Parameters
Figure 39 shows the Analysis tab of the Project Inputs form. Use the controls on
this tab to specify the duration of the analysis period (in years) and the mean discount
rate. The analysis period must be long enough to include at least one rehabilitation
treatment. The discount rate is used to discount future costs to the present values during
the life cycle cost analyses and is assumed to not include an inflation premium. If
conducting a probabilistic analysis, also enter the minimum discount rate, the maximum
discount rate, and the number of iterations to use in the Monte Carlo simulation process
(one iteration corresponds to the calculation of the life cycle costs associated with both
pavement alternatives, whereas 500 iterations corresponds to the calculation of 500 life
cycle costs associated with both pavement alternatives). A minimum of 300 iterations is
required, but 500 or more is recommended, with the maximum being 32,767 iterations.
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Use the drop-down list to select the initial units for displaying the cumulative present
worth cost of the pavement alternatives on the Results Viewer form (see Section 3.3).

Figure 39. Analysis Tab of the Project Inputs Form.

Saving Project Information
Once all of the required inputs have been entered in the controls on all tabs of the
Project Inputs form, clicking on the Save button saves this information to the database. If
the information pertains to a new project, then new records are created in the database.
If, however, the information pertains to a project that had been previously saved to the
database, then the LCCA software deletes all information that had been previously saved,
including analysis results (if any), and creates new records in the database that reflect the
new contents of the controls on all tabs of the Project Inputs form, but no records
containing analysis results. This feature allows retaining input data for numerous
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projects without any records containing analysis results, which, for probabilistic analyses,
amounts to a substantial number of records. Saving projects without analysis results can
help keep the database to a reasonable size.
Running Analyses
Clicking on the Start Analysis button also saves the information to the database
followed by running the life cycle cost analysis. When an analysis is running, the LCCA
software plots its progression in terms of percent complete on the Analysis Progress
frame. For example, Figure 40 shows that the probabilistic analysis is 70% complete, or
that 350 of the 500 iterations have been completed. When the analysis finishes, the
Results Viewer form is displayed. This form is discussed in the next section.

Figure 40. Display of Analysis Progression.
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If an analysis has been run for a project, the Analysis tab of the Project Inputs
form displays the View Results Button as shown in Figure 41. This button will be
displayed whenever an existing project is opened (if an analysis was run) or when an
analysis for a new project is run and the Results Viewer form has been closed. Clicking
on this button displays the Results Viewer form with the results from the last analysis
run. It is important to note that any changes to the input values will not be reflected in
the results displayed through use of the View Results button unless a new analysis is run.

Figure 41. Analysis Tab Displaying the View Results Button.

3.3

Results Viewer Form
The Results Viewer form displays results of analyses and allows you to print the

results to a printer and export the results to a comma separated value (.csv) file. This
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section provides details regarding the features of the Results Viewer form as well as how
to print and export analyses results.
Figure 42 shows the Results Viewer form displaying results of a deterministic
analysis. The results (in the form of a cost stream) are displayed for Alternative 1
initially. Clicking on the radio button for Alternative 2 displays the results (cost stream)
for Alternative 2 while clicking on the Comparison Plot radio button displays the results
for both Alternative 1 and Alternative 2 graphically as shown in Figure 43.

Figure 42. Results Viewer Form.
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Figure 43. Comparison Plot of the Cumulative Present Worth Cost for Both Alternatives.

When the Results Viewer form is displaying a cost stream (i.e., a grid) you can
change the units for displaying cumulative present worth costs through the View menu.
Clicking on the View menu and selecting the desired units accomplishes this. Figure 44
indicates that units of $/sq yd are being displayed.

Figure 44. View Menu of the Results Viewer Form.
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Clicking on the Inputs menu choice of the View menu displays a summary of the
inputs as shown in Figure 45.

Figure 45. Summary of Inputs as Displayed by the Results Viewer Form.
Also when the Results Viewer form is displaying a cost stream (i.e., a grid) you
can use the Page Setup and Print Preview features under the File menu (Figure 46) to
setup the page and print the results to a printer. Figure 47 shows the Page Setup feature
while Figure 48 shows the Print Preview feature.

Figure 46. File Menu of the Results Viewer.
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Figure 47. Page Setup Feature of the Results Viewer.

Figure 48. Print Preview Feature of the Results Viewer.
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Clicking on the File menu and selecting the Export… menu choice allows you to
export the data to a comma separated value (.csv) file that can be imported directly into
spreadsheet programs such as Microsoft Excel or Corel Quattro Pro. Figure 49 shows the
dialog that is displayed when File/Export… is selected. This dialog allows you to save
the file to any disk contained in the computer (except CDs).

Figure 49. Dialog for Exporting Results to Disk.
Figure 50 shows the results for a probabilistic analysis. As indicated, summary
statistics of the analysis are displayed. Cost streams are not displayed due to the large
number of them (two for each iteration in the Monte Carlo simulation process). Instead,
a cumulative probability distribution is generated from these cost streams. Clicking on
the Probability Plot radio button displays the cumulative probability distribution for the
analysis as shown in Figure 51. This is a cumulative distribution of the LCC of
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Alternative 1 minus the LCC of Alternative 2 for all iterations in the Monte Carlo
simulation process. Thus, values less than zero indicate that the LCC of Alternative 1
was less than the LCC of Alternative 2, whereas values greater than zero indicate that the
LCC of Alternative 1 was greater then the LCC of Alternative 2. For this example case,
approximately 86% of the LCC calculations indicated that Alternative 1 was less than
Alternative 2. The plot also indicates that for this example case, the best probabilistic
estimate of the life cycle cost savings from using lime was $2.37/sq yd.

Figure 50. Summary of Results for a Probabilistic Analysis.
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Figure 51. Cumulative Probability Plot.

Clicking on the File menu and selecting Exit closes the Report Viewer form and
returns control to the Project Inputs form. Clicking on the small close symbol ( ) in the
upper right corner of the Report Viewer accomplishes this as well.
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